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3.1 Введение 
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Глава 1. Понятие томографии. 

1.2 Общие принципы томографии. 
Современную томографию можно без преувеличения считать 

всеволновой. В зависимости от характера конкретной задачи восстановление 

структуры объекта может основываться на регистрации пучков электронов, 

ионов (в том числе протонов и альфа-частиц), нейтронов, фотонов во всем 

диапазоне электромагнитного спектра, звуковых волн. 

Исследуемый объект при этом облучается извне или сам является 

излучателем. Просвечивающие источники могут быть когерентными (в ряде 

задач это обстоятельство чрезвычайно важно) и некогерентными. 

Детектироваться могут как широкие, так и узкие (приближенно-

монохроматические) участки спектров испускания, поглощения, рассеяния. 

Измеряются также фазовые искажения фронта волны (шлирен-, теневые и 

интерферометрические методы), сигналы свободной индукции (ЯМР-

интроскопия), углы поворота плоскости поляризации (вычислительная 

томография основанная на эффекте Фарадея) и т. п. В последнее время все 

шире используется эффект электрон-позитронной аннигиляции с применением 

схемы совпадений. 



Казалось бы, при таком разнообразии средств и методов получения 

данных не может существовать сколько-нибудь универсальной процедуры, 

позволяющей перейти от измеряемых величин к элементам внутренней 

структуры объекта. Однако указанный комплекс обратных задач все же 

содержит некий единый стержень. 

Возьмем для определенности случай несамосветящегося и недоступного 

для визуального изучения объекта, просветить который мы можем, например, с 

помощью рентгеновских лучей. 

Недостатки обычной рентгенограммы, представляющей собой двумерную 

теневую проекцию реальной трехмерной структуры, хорошо известны. Это - 

неизбежные наложения структурных элементов, невозможность 

количественного сопоставления отдельных локальных фрагментов тела по 

плотности и иным параметрам. Ясно также, что и располагая набором таких 

рентгенограмм, снятых с разных направлений, исследователь практически 

немного выиграет с точки зрения количества извлекаемой информации о 

внутреннем строении объекта, если будет действовать стандартным способом, 

последовательно разглядывая снимки. 

Метод заметного повышения информативности рентгенограммы 

предложил еще в 20-х годах французский врач Бокаж, а его идею вскоре 

реализовал на практике итальянский инженер Валлебона, назвавший созданный 

им аппарат томографом. Суть идеи непосредственно видна из рис. 1.1. Если во 

время съемки рентгенограммы перемещать в параллельных плоскостях любые 

два из трех участвующих в ней компонента (рентгеновская трубка, объект, 

фотопленка), оставляя неподвижным третий, то на пленке даст четкое 

изображение только один слой, а элементы остальных слоев размажутся. 

Регулируя скорости перемещений, можно выделять различные слои и тем 

самым последовательно изучать структуру трехмерного объекта. 

 
Рис. 1.1. Схема томографии по Бокажу. 

Источник S1 перемещается в положение S2, в плоскости А, в то время как 

рентгеновская пленка R1 переходит в положение R2 (плоскость B). Резко 



воспроизводится плоскость F; детали объекта О, соответствующие плоскости F' 

и F", размываются. 

Тем не менее, легко понять, что принцип последовательного выделения 

сечений тела за счет взаимных смещений компонентов диагностической 

установки нельзя считать сколько-нибудь универсальным. Если иметь в виду 

даже только медицинскую рентгенологию, то и в этом случае значительного 

увеличения контраста различных органов достигнуть не удается: этому 

препятствует неизбежная паразитная засветка от других, расфокусированных 

сечений тела. Последовательный перебор одного сечения за другим сопряжен с 

большими дозами облучения; как и в обычной рентгенодиагностике, в 

основном приходится довольствоваться лишь качественным сравнением 

плотностей почернений различных участков и т. п. Что же касается 

томографирования самосветящихся объектов (физика плазмы, 

высокотемпературная газодинамика), применений в электронной микроскопии, 

геофизике, атмосферных и космических исследованиях, то здесь описанный 

выше принцип заведомо неэффективен. 

Современная вычислительная томография использует совершенно иной 

подход при выделении интересующего нас сечения неоднородного объекта. 

Поясним его на том же примере, относящемся к рентгеновской диагностике 

(рис. 1.2). Излучение рентгеновского источника может быть хорошо 

сколлимировано: до диаметров пучка порядка одного или нескольких 

миллиметров, так что возникают достаточно веские основания говорить о 

просвечивающих лучах. Каждый такой луч, прошедший через тело, 

характеризуется своей интесивностью, ослабленной по отношению к исходной. 

 
Рис. 1.2. Схема вычислительной томографии. 

а) Коллимированный пучок лучей проходит в плоскости F, ослабляется 

объектом О и регестрируется детектором D; влияние плоскостей F' и F" 

полностью устранено. б) Вид на плоскость F сверху: источник и детектор 



перемещаются, образуя набор луч сумм и формируя проекцию. Затем 

происходит поворот на некоторый угол. Показано получение трёх проекций. 

Далее, перемещая луч по определенному закону в выбранной плоскости 

(например, параллельно самому себе или веером с некоторым углом раствора), 

получаем набор луч-сумм, определяющий одномерную проекцию. Будем для 

определенности говорить о параллельном смещении зондирующих лучей; тогда 

одной проекции соответствует некоторый угол относительно выбранной 

системы отсчета. Поворачивая затем луч в той же плоскости на малый угол, 

повторяем процесс регистрации луч-сумм и получаем новую проекцию и т. д. 

Процесс сканирования по углу продолжается до тех пор, пока полный угол 

поворота не составит 180°. В результате в памяти ЭВМ накапливается 

необходимая исходная информация для реконструкции изображения в 

выделенной плоскости (сечении). При этом отсутствуют какие-либо помехи в 

виде размытых элементов изображения, соответствующих другим плоскостям, 

и теоретически можно ожидать весьма высокого контраста томограммы. 

Возможность количественной оценки плотностей структурных элементов при 

использовании ЭВМ очевидна. Нетрудно убедиться, что метод пригоден также 

при исследовании излучающих и рассеивающих объектов, хорошо сочетается с 

техникой голографической интерферометрии, ЯМР и ЭПР, поляризационных 

измерений и т. п. 

Описанный принцип томографирования в начале 60-х годов одним из 

первых применил А. Кормак в модельных экспериментах, ориентированных на 

медицинскую рентгенодиагностику. 

Исключительная гибкость метода вычислительной томографии 

порождает, с одной стороны, большое разнообразие применяемых при 

получении томограмм физических, технических и расчётно-математических 

решений, с другой стороны, обеспечивает методу чрезвычайно широкое поле 

приложений. 

1.3 Классификация методов вычислительной томографии. 
Проблема восстановления структуры многомерного объекта по 

совокупности его проекций возникла давно, и в настоящее время имеется много 

способов ее решения. 

Методы, которые получили наибольшее распространение в различных 

приложениях и сыграли важную роль в развитии вычислительной томографии, 

можно разделить на два основных класса: аналитические и итерационные. 

Аналитические методы основаны на точных математических решениях 

уравнений восстановления изображения. В основе большинства из них 

используются аппарат преобразования Фурье и преобразования Радона. Все 

аналитические методы реконструкции изображения теоретически 

эквивалентны, однако отличаются процедурой реализации. В связи с этим их 

можно в свою очередь разделить на две основные группы - двухмерное 

восстановление Фурье и обратная проекция с фильтрацией 

Итерационные методы восстановления изображения используют 

аппроксимацию восстанавливаемого объекта массивом ячеек равной 



плотности, представляющих собой неизвестные величины, связанные системой 

линейных алгебраических уравнений, свободными членами которых являются 

отсчеты на проекции. Решаются системы уравнений итерационными методами, 

что и дало название данному классу методов восстановления. В настоящее 

время известно несколько итерационных методов восстановления изображения. 

Отличаются они в основном последовательностью внесения поправок во время 

итерации. Среди них наиболее известны и употребительны три метода: 

алгебраический метод восстановления (ART), метод одновременного 

итерационного восстановления (SIRT) и итерационный метод наименьших 

квадратов (ILST). 

Кроме названных выше двух основных классов методов необходимо 

упомянуть о методе обратной проекции. Несмотря на то, что этот метод 

восстанавливает изображение со значительными ложными сигналами, его 

нужно привести, потому что он очень прост, понятен, нашел применение в 

первых экспериментах и, что самое главное, входит в состав основных точных 

методов. Поэтому на этом методе я поподробнее остановлюсь во второй главе. 

Глава 2. Постановка задачи и методы томографирования. 

2.1 Основные определения и постановка задачи томографии. 

Обычно для восстановления трехмерной функции  используют 

одномерные проекции ее двухмерных сечений  при фиксированном , 

т.е. как бы восстанавливают послойно при разных  двухмерные сечения 

объекта ("томография"- описание сечений). 

В основном рассматриваемые алгоритмы излагаются на примере 

восстановления двухмерных объектов. Сделано это по нескольким причинам. В 

случае двухмерной задачи упрощаются система обозначений и математические 

выкладки. А для восстановления изображения во всем объеме трехмерный 

объект может быть аппроксимирован набором двухмерных сечений при 

условии, что они расположены достаточно густо, и, следовательно, трехмерная 

задача восстановления может быть сведена к последовательности двухмерных 

задач. В общем случае к ряду двухмерных задач, в принципе, может быть 

сведена любая N-мерная задача. Такая процедура оказывается более 

эффективной с точки зрения вычислений, так как при этом обычно требуются 

значительно меньший объем памяти и менее сложные вычисления, чем при 

прямом решении N-мерной задачи. Кроме того, существенно упрощается 

механическая часть всего устройства томографа. 

Пусть двухмерное сечение исследуемого объекта описывается функцией 

плотности . За пределами сечения плотность предполагается равной 

нулю. 

Рентгеновская трубка излучает пучок лучей в плоскости исследуемого 

сечения объекта. Рассмотрим случай, когда рентгеновский пучок имеет вид 

параллельных лучей. После прохождения рентгеновского пучка через сечение 

ослабленные пропорционально плотности объекта лучи воспринимаются 

детекторами. Система трубка - детекторы вращается вокруг исследуемого 

сечения. С системой трубка - детектор связана подвижная система 



координат , центр которой совпадает с центром системы , а оси 

повернуты относительно неподвижной системы на угол  . Направление лучей 

совпадает с координатой u (рис.2.1). 

 
Рис. 2.1. Расположение объекта в системе трубка - детектор в случае 

параллельных лучей: 1 - объект; 2 - источник излучения; 3 - приемник. 

Лучи определяются их расстоянием от начала координат v и углом 

поворота относительно неподвижной системы координат . Любая точка 

функции  может быть задана как в системе , так и в системе , при 

этом координаты связаны уравнениями преобразования. 

 

(
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и наоборот 
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Проекция, в общем случае, - это отображение N-мерной функции в (N-1)-

мерную функцию, получаемое путем ее интегрирования в заданном 

направлении. В рассматриваемом двухмерном случае за направление 

интегрирования выбирается ось u, совпадающая с направлением лучей 

рентгеновского источника. Тогда проекция p функции  будет определена как 

 

(

2.3) 

или для подвижной системы координат при различных  получим набор 

проекций: 

 

(

2.4) 

где  - угол, под которым получена проекция. Информация о проекциях 

снимается с детекторов. 



Исходным материалом для задачи восстановления является набор 

проекций , полученных под разными углами  . Если бы мы располагали 

неограниченным количеством по-разному ориентированных проекций, то в 

принципе могли бы получить точное восстановление функции. Однако в любом 

практическом случае количество проекций ограничено. Тем не менее, при 

определенных допущениях восстановление можно выполнить и по конечному 

числу проекций. 

Итак, задача восстановления, практически заключающаяся в решении 

интегрального уравнения (2.4) , может быть сформулирована следующим 

образом: по конечному числу проекций  , измеренных под разными 

углами и заданных в свою очередь дискретно, требуется восстановить значение 

функции . Количество проекций существенно влияет на точность 

восстанавливаемого изображения. 

Все многочисленные вычислительные алгоритмы, применяемые в 

томографии, направлены на то, чтобы найти в некотором отношении 

оптимальную оценку решения в заданном классе искомых 

функций  (например, наиболее "гладкое" из допустимых решений или 

наиболее вероятную оценку  и т.п.) 

2.2 Восстановление сечений с использованием Фурье 

преобразований. 
Самый естественный и мощный способ решения задачи восстановления 

дает преобразование Фурье. Перейдем от функции  к ее Фурье 

образу  и соответственно от  к Фурье образу  (

,  - повернутые на угол  координаты в Фурье-плоскости) 

Одним из основных свойств преобразования Фурье является его 

линейность, из чего следует, что если  поворачивается на угол  , то 

соответствующее преобразование Фурье тоже поворачивается на угол  . 

, (

2.5) 
 

и наоборот 

, (

2.6) 
 

 - подвижная система координат в Фурье плоскости. 

 

(

2.7) 

 

(

2.8) 

(2.8)- преобразование Фурье; (2.7) - обратное преобразование Фурье. 

Положим в уравнении (2.8) , тогда 



 

(

2.9) 

Сравнив (2.9) с (2.4) видим, что Фурье-образ искомой функции в точках 

Фурье-плоскости, лежащих на прямой , есть одномерный Фурье-образ 

соответствующей проекции  - это так называемая теорема о проекциях и 

сечениях (2.11): 

т

.е. так 

как 

 

,

 

то 

 

 

(

2.10) 

 

(

2.11) 

Таким образом, теорема позволяет вычислить Фурье образ искомой 

функции во всех точках Фурье плоскости  , вычисляя Фурье образ 

проекции при разных  , а затем по формуле обратного преобразования Фурье 

(2.7) восстановить саму функцию. Можно, перейдя в полярные координаты, 

получить формулу эквивалентную (2.7). Используются при этом следующие 

соотношения: 

 

 

 

 

элемент площади при переходе от декартовых координат к полярным 

 

,тогда 

 

 

 

 

 

(

2.12) 

Hа формуле (2.12) построен ряд конкретных вычислительных 

алгоритмов, в частности, метод обратной проекции. 

Метод обратной проекции 

2.3 Метод обратной проекции. 



Простейший вариант этого метода оценивает плотность в любой точке 

сечения посредством сложения лучевых сумм  для всех лучей, 

проходящих через искомую точку. Рассмотрим пример, когда для 

восстановления используются только три проекции (рис.2.3a,2.3b), хотя для 

практических целей потребуется гораздо большее их число. 

 
Рис. 2.3a Проекции снятые с объекта (объект - белое пятно) 

view1,view2, view3 - проекции. 



 
Рис. 2.3b Восстановление объекта (белого пятна) методом "обратной 

проекции" 

view1,view2, view3 - проекции. 

Восстановление производится путём обратного проектирования каждой 

проекции через плоскость, т.е. величина сигнала, соответствующая данной 

лучевой сумме, прикладывается ко всем точкам, которые образуют этот луч. 

После того, как это сделано для всех проекций, получается приближённая 

аппроксимация исходного объекта. Так как в этом методе проекции как бы 

растягиваются обратно через восстанавливаемое сечение, метод назван 

обратной проекцией. Для каждой точки изображения восстановленная 

плотность является суммой всех лучевых проекций, которые проходят через эту 

точку. Поэтому метод обратной проекции иногда называется методом 

суммирования или линейной суперпозиции. Математическое описание метода 

обратной проекции может быть представлено: 

если в (2.12) принять , тогда 

 

(

2.13) 

Или при измерении конечного числа проекций 

 

(

2.14) 



где суммирование производится по всем углам проекции . Аргумент 

 

(

2.15) 

соответствует только тем лучам, которые проходят через точку , 

коэффициент  представляет угловое расстояние между соседними 

проекциями, М - количество проекций. Величина, полученная с помощью 

уравнения (2.14), не идентична истинной плотности. Как видно из рисунка 

(рис.2.3), восстановленная картина содержит значительный ложный сигнал. Это 

происходит потому, что точки за пределами исходного объекта получают часть 

интенсивности спроецированного обратного сигнала. Кроме того, точки внутри 

объекта получают интенсивность составляющих сигнала от соседних точек, в 

результате чего небольшие перепады плотности не различаются. 

Можно показать, в чём состоит причина невысокой точности метода 

обратной проекции. Предположим, что восстанавливаемый объект состоит из 

одной точки. Тогда результат восстановления по проекциям методом 

суммирования будет представлять собой не точку, а многолучевую звезду, 

центр которой находится в восстанавливаемой точке (рис.2.4). 

 

 

 

Рис. 2.4 Восстановление точечного объекта методом "обратной 

проекции": а - объект (1) и его проекции (2); б - обратное проецирование; ясно 

видно формирование фона в пространстве, окружающем точку. 

Очевидно, что точка будет представлена наиболее ярко, но в то же время 

на окружающее пространство эта точка будет накладывать фон, 



пропорциональный 1/ , где  - расстояние от точки 1. Фон и является 

основным источником погрешностей, которые снижают достоинства этого 

метода. Метод суммирования был независимо открыт Б.К.Вайнштейном и 

Р.Гордоном. 

2.4 Обратная проекция с фильтрацией свёрткой. 
Более точный результат по сравнению с методом обратной 

проекцииМетод обратной проекции, дает обратная проекция с фильтрацией 

сверткой. 

Обратное проецирование с фильтрацией аналогично методу обратной 

проекции за исключением того, что профили до обратного проецирования 

модифицируются или фильтруются, т.е. в (2.12) . Это позволяет вывести 

эффект затемнения, присущий методу обратной проекции. В идеальном случае 

восстановленное изображение совершенно точное, поскольку модификация 

профилей точно компенсирует ложный сигнал, создающий нерезкое 

изображение при обратном проецировании. 

Предположим, что  есть Фурье-образ некоторой функции , 

 

(

2.16) 

тогда произведение  на Фурье-образ проекции можно рассматривать 

как Фурье-образ свертки самой проекции и  

 

(

2.17) 

из (2.12) следует, что формула описывающая метод обратного 

проецирования с фильтрацией свёрткой при измерении конечного числа 

проекций будет: 

 

(

2.18) 

где  - результат свертки измерений проекции  с некоторой 

функцией , называемой ядром свертки. Как и в методе обратного 

проецированияМетод обратной проекции, суммирование идёт по М - 

количеству проекций, а коэффициент  представляет угловое расстояние 

между соседними проекциями. 

Точное вычисление  невозможно ввиду расходимости этого 

интеграла, но это и не нужно, т.к. дискретизация отсчетов на проекциях через 

интервалы автоматически ограничивает область 

задания  максимальным значением . Ядро  в 

пределах от  до  вычисляется: 

 

(

2.19) 

Если положить , то . 



, если  четное, 

 , если  нечетное. 

 
Рис. 2.5. Функция ядра свёртки (по обеим осям относительные единицы). 

Такое ядро впервые было исследовано А. Лакшминараянаном и 

Г.Рамачандраном и обычно называется их именами. Следует отметить, что 

выбор ядра существенно влияет на качество восстанавливаемого изображения. 

Поэтому выбор ядра является предметом тщательного исследования с учётом 

особенностей объекта, подлежащего восстановлению. 

Процедура восстановления функции по методу обратной проекции с 

фильтрацией сверткой будет следующая: 

1. Находим функцию  как интеграл свертки проекции  с 

функцией ядра свертки . 

2. Определяем функцию  в точках v. 

3. Вычисляем искомую функцию , используя уравнение (2.18). 

Удобство алгоритма обратной проекции с фильтрацией состоит в том, что 

вычислительный процесс восстановления может идти почти одновременно с 

регистрацией проекции: как только получена очередная проекция , 

осуществляется ее свертка с ядром  и добавление данных в ячейки памяти, 

накапливающие результаты суммирования по формуле (2.18). Как только 

обработана последняя проекция, функция восстановлена. 

2.5 Итерационные методы восстановления 

2.5.1 Определение. 
Термин “итерационный” относится к методу последовательных 

приближений, при котором выбирается произвольное начальное изображение; 

для него рассчитываются проекции, а затем в изображение вводятся поправки 

для лучшего согласования этих проекций с измеренными проекциями. 



Итерации повторяются до тех пор, пока не будет получена удовлетворительная 

сходимость. 

2.5.5 Алгебраический метод восстановления (ART) или получевая 

коррекция. 
Этот метод был независимо разработан Гордоном и др., который назвал 

его методом алгебраического восстановления (ART – Algebraic Reconstruction 

Technigues). Процедура восстановления следующая. В каждой итерации 

вычисляется сначала одна лучевая сумма при исходном значении плотности в 

ячейках . По ней и с учетом измеренной лучевой суммы определяется 

поправка, которая вводится во все точки, входящие в состав данного луча. 

Затем операция повторяется для второго луча, третьего и т.д. При этом 

поправки, введенные от предыдущей лучевой суммы, учитываются в каждом 

новом расчете. Эти операции продолжаются до тех пор, пока не будут 

обработаны все проекции, после чего итерация завершена. Если критерий 

получения решения не удовлетворён, то происходит переход к следующей 

итерации. 

Рассмотрим элементарный пример реконструкции двумерного объекта, 

когда сам объект предельно прост, алгоритмический “механизм” совершенно 

прозрачен, а привлечения ЭВМ вообще не требуется. 

Возмём в качестве такого объекта квадрат ABCD (рис. 2.7.), разделённый 

на 9 равных клеток (ячеек). Числа от 1 до 9, разбросанные по клеткам, 

соответствуют плотности или какой-нибудь другой характеристике, находимой 

томографически. Пусть известны 4 проекции, определяемые направлениями 

сторон квадрата AB и AD и его диагоналей AC и BD. Если в каждой проекции 

взять по 3 луч-суммы, то в первых двух случаях вклад внесут все клетки, а в 

двух других лишь по 7 клеток из 9. Таким образом, мы исходим из 12 значений 

луч-сумм и ищем 9 структурных элементов объекта, т.е. решаем 

переопределённую задачу. 

 
Рис. 2.7. Тест-объект из девяти элементов. 



Начнем с проекции, образованной лучами, параллельными стороне AB. 

Каждое значение луч-суммы разделим на число пересекаемых клеток и 

припишем этим клеткам найденную величину (в данном случае 5). Будем 

считать полученный результат первой итерацией (рис. 2.8 A). Как видим, в 

нашем случае для взятой проекции объект представляется совершенно 

однородным; если погрешность восстановления оценивать по формуле 

 

(

2.26) 

где индекс ‘k’ нумерует клетки, i обозначает номер итерации, - 

исходные значения на рис. 2.7., то . 

Перейдем к следующей проекции (лучи идут вдоль AD). Теперь для 

каждого луча следует скорректировать сумму чисел, получаемых после первой 

итерации, на известную луч-сумму данной проекции. Так, сумму в первом 

столбце (15) следует, очевидно, уменьшить на 2 и вычесть из каждого числа по 

2/3; в третьем столбце нужно, наоборот, добавить в каждую клетку по 2/3; во 

втором столбце изменений нет. Видно, что в нашем примере вторая итерация 

фактически оказывается неинформативной: предыдущее однородное 

распределение лишь слегка деформируется, создавая небольшой градиент 

вдоль AB и совершенно не выявляя сложной структуры объекта (рис. 2.8 B). 

Погрешность восстановления, оцениваемая по (2.26), даже несколько 

возрастает по сравнению с первой итерацией: . 

 

 



 
Рис. 2.8. Различные стадии (A-F) восстановления тест-объекта, 

изображенного на рис.2.7. 

Третья Итерация (рис. 2.8 C, лучи идут параллельно диагонали AC) уже 

резко меняет дело, поскольку в значениях луч-сумм неоднородность объекта 

проявляется отчетливо. Принцип остается прежним, только соответствующие 

разности следует равномерно распределять по двум или трем клеткам в 

зависимости от того, какая луч-сумма принята в расчет; . 

Аналогичная ситуация имеет место и с четвертой итерацией (рис. 2.8 D), 

завершающей первый цикл процедуры; теперь объект уже напоминает 

исходный, . 

Далее можно вновь привлечь первую проекцию и начать, таким образом, 

второй цикл. На рис. 2.8 Е,F показаны результаты, получаемые после шестой (

) и восьмой ( ) итерацией. Процесс можно было бы, 

конечно, продолжать и дальше, но уже и из проделанных выкладок ясно, что 7-

8 итераций позволяют получить неплохой результат восстановления. 

2.5.6 Итерационный метод наименьших квадратов (ILST) или 

одновременная коррекция. 

В простейшем случае алгоритм этого метода (ILST- Iterative Least-Squares 

Technique) следующий. Все проекции вычисляются в начале итерации при 

исходном значении плотности ячеек . По расчетным проекциям 

определяются поправки для каждой ячейки . А затем коррекции вводятся 

одновременно во все ячейки. На этом итерация завершается. Таким образом в 

этом алгоритме не производится уточнение значения плотности в ячейке  в 

течении итерации. Изменяется плотность в  один раз за итерацию. Этот 

метод впервые применен Р.Брейсвеллом. Он же показал, что в таком варианте 

алгоритм приводит к перекоррекции, в результате чего итерации колеблются 

вокруг правильного решения. 

Глава 3. Описание программы TOMOGRAPHY1. 

3.1 Введение. 

Одним из современных методов диагностики плазмы является метод 

реконструктивной компьютерной томографии. Томографический подход 

позволяет с достаточно высокой степенью точности определять локальные 

характеристики исследуемых неоднородных плазменных объектов, что даёт 

широкие возможности в понимании физических процессов, протекающих в 



этих объектах. Качество реконструкции существенно зависит от таких 

факторов, как число направлений наблюдения (ракурсов), количество 

детектирующих устройств, устойчивость алгоритма к шумам. 

Численное моделирование позволяет определить оптимальные условия 

постановки томографического эксперимента. 

Разработанная обучающая программа “Tomography 1” позволяет 

вычислять проекции математических моделей неоднородных плазменных 

объектов, наглядно демонстрировать восстановление осесимметричного и 

асимметричного объектов при выбранном числе проекций (ракурсов 

наблюдения), накладывать на проекции шумы, представлять результаты 

восстановления в трёхмерном виде, воспользовавшись нормировкой, 

определять точность восстановления, и проводить общий анализ зависимости 

точности восстановления объекта от числа проекций. 

Работа реализована на основе одного из самых мощных аналитических 

способов решения задачи восстановления - преобразования Фурье - и 

вытекающие из него вычислительные методы непосредственно использованы в 

этой программе: "метод обратной проекции" и "фильтрация сверткой". 

Несмотря на то, что метод обратной проекции восстанавливает 

изображение со значительными ложными сигналами и в настоящее время не 

применяется, он приводится потому, что очень прост, интуитивно понятен, 

нашел применение в первых экспериментах и, самое главное, входит в состав 

основных точных методов. Кроме того, представляется возможность наглядно 

сравнить оба способа восстановления. 

Метод же обратного проецирования с фильтрацией используется во 

многих современных рентгенодиагностических томографов и, таким образом, с 

чисто утилитарной точки зрения играет особую роль. 

Также в программе реализованы два итерационных метода томографии: 

алгебраический метод восстановления (ART- Algebraic Reconstruction 

Technigues) или получевая коррекция и итерационный метод наименьших 

квадратов (ILST - Iterative Least-Squares Technique) или одновременная 

коррекция. 

3.2 Описание программы. 
При запуске программы “Tomography1.exe” на экране появляется главное 

окно – “Tomography 1” (рис.3.1), 



 
Рис.3.1 Главное окно программы Tomography 1. 

на котором расположены компоненты, позволяющие задавать параметры 

и управлять работой программы: 

 
Рис.3.2 

В меню “File” (рис.3.2) 

предусмотрена возможность выхода 

из программы (Exit), сохранения 

полученного графика в BMP 

формате (Save graph), сохранение 

смоделированных проекций в txt 

формате (Save model projections), 

сохранить обработанные данные в 

txt формате (Save treated datas), 

загрузка экспериментальных 

данных (Open experimental 

projections). 

 
Рис.3.2a 

В меню “Regime” (рис.3.2a) 

задается режим работы программы: 

работа с мат. моделями (Model), 

работа с загружаемыми 

экспериментальными данными 

(Experimental data) 



 
Рис.3.3 

Из меню “Options” 

вызываются модули для задания 

математической модели (Model…), 

показа заданной модели в 3-х 

мерном виде (Show model…), 

задания уровня шумов (Noise 

level…), установки параметров 

отображения восстановленного 

объекта (Set-up of an image…), 

вывод информации о точности 

восстановления объекта (Error…). 

 
Рис.3.4 

Из меню ”Help” вызывается 

подробная справка по описанию 

программы “Tomography 1” и 

методическая информация по 

томографии (понятие томографии, 

математическое описание методов 

томографирования, особенности 

томографии плазменных объектов) 

 
Рис.3.5 Справочная система программы Tomography 1. 



 
Рис.3.6 Задание мат. модели. 

из меню “Options”, 

главного окна, 

вызывается модуль для 

задания математической 

модели (Model…) 

(рис.3.6). В окне 

пользователь выбирает 

комбинацию 

функций Гаусса (до 9 

штук), задает 

коэффициенты (a и b) и 

устанавливает 

максимальные 

(Xmax,Ymax) и 

минимальные 

(Xmin,Ymin) значения 

по осям. Далее 

нажимается кнопка 

“Show model” для 

просмотра самой модели 

(рис.3.6a). 



 
Рис.3.6a Созданная пользователем модель. 

В правом верхнем углу указывается растр модели (Raster NxN), “Turn of a 

system ” – показывает углы поворота системы координат (“X”,”Y”,”Z”). 

Предусмотрена возможность поворота простым движением мышки. Кнопка 

“Show” служит для перерисовки модели, если она была изменена. Normalization 

выделяется, если нужно осуществить нормировку модели (при определении 

погрешности восстановления нормировка происходит автоматически). В меню 

“File”,”Options” и “Help” аналогичные пункты, что и в главном окне. 

После того, как задана модель, нужно вернуться в главное окно (рис.3.1) 

(оно все время открыто). Компоненты, расположенные на нем, позволяют 

осуществлять: 

 

Для просмотра проекции с математической 

модели, задается число отсчетов – “Readount on a 

projection”, угол поворота“Turn angle” и нажимается 

кнопка “Projection”(рис.3.7) (результат на рис.3.9a). 

Для вывода ядра свертки, выбирается ядро (Nucleus 

Ramachandrana или MHAT wavelet) и нажимается 

кнопка “Nucleus”(рис.3.7) (результат на рис. 3.9с,10). 

Для просмотра свертки ядра с выведенной проекцией 



Рис.3.7 нажимается кнопка “Convolution” (рис.3.7) (результат 

на рис. рис.3.11,12). 

 
Рис.3.8 

Для восстановления модели задается растр 

томограммы “Raster tomography NxN”, число проекций 

“Amount of projections M”, угловой шаг “Angular pitch”, 

алгоритм восстановления “Algorithm”, указывается 

проводить ли нормировку “Normamalization” и 

нажимается кнопка “Reconstruction”. Для вывода на 

экран предназначена кнопка “Show”. 

В режиме обработки экспериментальных данных 

(Regime-> Experimental data) может произвольно 

задаваться угловой шаг (но не рекомендуется менять 

загруженное значение), выбирается алгоритм 

восстановления, растр томограммы и число проекций 

устанавливаются автоматически. 

 
Рис.3.8a 

 
Рис.3.8b 

Программа позволяет на 

смоделированные проекции накладывать 

случайный шум “Options->Noise 

level”(Рис.3.8a). Амплитуда шумов 

устанавливается в процентном соотношении от 

текущего значения отсчета (Рис.3.8b). 

Сгладить проекцию с шумом можно, применив 

метод наименьших квадратов “To smooth” 

(Рис.3.8b). Пример проекции с 20-ти 

процентным шумом показан на Рис.3.9b. 



 
Рис.3.9a Проекция с мат. модели под углом 20 градусов, 100 отсчетов. 

 
Рис.3.9b Проекция с мат. модели под углом 20 градусов, 100 отсчетов, 

с 20-ти процентным шумом (график красного цвета), 

сглаженная проекция (график зеленого цвета) 



 
Рис.3.9c Ядро Рамачандрана. 

 
Рис.3.10 MHAT wavelet. 



 
Рис.3.11 Свертка проекции с MHAT wavelet. 

 
Рис.3.12 Свертка проекции с ядром Рамачандрана. 



Ниже приведены изображения с восстановленными моделями с 

использованием различных алгоритмов. 

 
Рис.3.13 Метод обратной проекции (погрешность восстановления 

55.219%). 



 
Рис.3.14 Метод обратной проекции с фильтрацией 

сверткой (погрешность восстановления 6.083%, ядро Рамачандрана). 

 
Рис.3.15a 

 
Рис.3.15b 

Алгоритмы ART и ILST являются 

итерационными, поэтому перед восстановлением 

проекций данными алгоритмами, нужно задать 

число итераций. Для этого в блоке “Alkhoritm” 

кликаем правой кнопкой мыши на пункт “Art” или 

”ILST” для вызова выпадающего меню “Iterations” 

(Рис.3.15a). Появляется окно “Iterations” 

(Рис.3.15b), где можно задать число итераций в 

алгоритме восстановления. 



 
Рис.3.15c Метод ART (погрешность восстановления15.511%, 10 

итераций). 



 
Рис.3.16 Метод ILST (погрешность восстановления 15.876%, 5 итераций). 

 
Рис.3.17 Вывод информации 

о точности восстановления. 

Из меню “Options->Error…”, 

главного окна, вызывается модуль 

вывода информации о точности 

восстановления объекта “Exactness” 

(Рис.3.17). В модуле определяется 

как общая погрешность “To 

calculate”, так и абсолютная 

погрешность каждого элемента 

восстановленного объекта (The 

absolute error). Абсолютная 

погрешность выводится в виде 

некоего поля ошибок (рис.3.18) 



 
Рис.3.18 Абсолютная погрешность (поле ошибок). 

Разность между идеальной моделью и восстановленной методом 

обратного проецирования. До определения абсолютной погрешности и модель, 

и восстановленный объект были нормированы. 

 
Рис.3.19 Параметры отображения 

В программе можно 

задать параметры 

отображения 

восстановленного объекта 

(Меню “Options-> Set-up of an 

image…”). 

“Points”-отобразить 

объект точками (рис.3.20) 

(при этом существенно 

экономятся вычислительные 

ресурсы); 

“Triangulation”-

триангуляция объекта; 

“Halftints”- отобразить объект 

полутонами (рис.3.21); 

“Site”- отобразить 

сетку; “Axes” – показать оси 



координат; “Grid”- показать 

основание. 

“Color triangulation”- 

цветная триангуляция 

(рис.3.22). 

 
Рис.3.20 Отображение объекта точками. 



 
Рис.3.21 Отображение объекта полутонами. 

 
Рис.3.22 Отображение объекта в цветной триангуляции. 



Практические задания к лабораторной работе. 

Порядок работы. 

1. Внимательно ознакомиться с данным методическим руководством. 

2. Запустить обучающую программу Tomography1.exe 

3. Убедиться, что установлен режим моделирования (“Regime”). 

Создание математической модели неоднородного плазменного объекта. 

4. Создать математическую модель из комбинаций функций Гаусса (не 

менее 3-х функций). “Принтскрином” сохранить в графическом файле. 

Моделирование проекций. 

5. Вывести графики проекций с созданной мат. модели (не менее 3-х под 

различными углами). Сохранить графики в файлах (File->Save graph) 

6. Получить графики сверток проекций с ядрами (Рамачандрана и MHAT 

wavelet). Не менее 3-х под углами, использованными в пункте 5. Сохранить 

графики в файлах (File->Save graph). Проанализировать вид графиков сверток, 

сравнить их с обычными проекциями, написать вывод. 

Работа с алгоритмами томографии и определение влияния числа 

используемых проекций на точность восстановления. 

7. В блоке Reconstruction задать: растр томограммы (не менее чем 50х50), 

число проекций 2, рассчитать угловой шаг и задать его. 

8. Выбрать алгоритм томографии “Revers projection” и обработать им 

проекции. Вывести результат обработки на экран с установками отображения 

(Set-up of an image): Triangulation, Color site, Axes. Определить точность 

восстановления. “Принтскрином” сохранить изображение в графическом 

файле. 

9. Повторить пункты 7 и 8 для числа проекций 3,4,5,6,10,12. 

10. Построить график зависимости точности восстановления от числа 

используемых проекций. Проанализировать график, написать вывод. 

11. Повторить пункты 7,8,9,10 для алгоритмов томографии “Filtration by 

convolution” и “ART” (для “ART” задать число итераций равное 5). Сравнить 

полученные графики, написать вывод. 
Влияние шумов на профили проекций. 

12. В блоке “Noise level” задайте уровень шумов 15%, включите 

сглаживание шумов, получите график проекции с заданным уровнем шума и 

сохраните график. 

13. Получите свертку зашумленной проекции с ядроми Рамачандрана и 

MHAT wavelet (сохраните графики). Проанализируйте полученные графики, 

сделайте предположение о результате обработки подобных данных алгоритмом 

томографии “Filtration by convolution”. 

Влияние шумов на точность восстановления в различных алгоритмах 

томографии. 

14. В блоке Reconstruction задать: растр томограммы (не менее чем 

50х50), число проекций 10, рассчитать угловой шаг и задать его. В блоке “Noise 

level” задайте уровень шумов 15%, выключите сглаживание шумов. 



15. Выбрать алгоритм томографии “Filtration by convolution” и выполнить 

обработку. “Принтскрином” сохранить изображение в графическом файле. 

16. В блоке Reconstruction задать: растр томограммы (не менее чем 

50х50), число проекций 10, рассчитать угловой шаг и задать его. В блоке “Noise 

level” задайте уровень шумов 15%, включите сглаживание шумов. 

17. Выбрать алгоритм томографии “Filtration by convolution” и выполнить 

обработку. “Принтскрином” сохранить изображение в графическом файле. 

18. Повторить пункты 14,15,16,17 для алгоритмов “Wavelet filtration” и 

“ART”. Напишите сравнительный анализ полученных результатов. 

19. Внимательно перечитайте раздел “2.5.5 Алгебраический метод 

восстановления (ART) или получевая коррекция “. Придумайте свой тест-

объект размером 16 клеток (4х4) и распишите 6 итераций восстановления с 

указанием точности восстановления. 

Отчет должен содержать полученные рисунки, графики с комментариями 

и выводами, а так же выполненную самостоятельную работу по пункту 19. 

Отчет представляется в электронном виде. 

2.4 Обратная проекция с фильтрацией свёрткой. 
Более точный результат по сравнению с методом обратной 

проекцииМетод обратной проекции, дает обратная проекция с фильтрацией 

сверткой. 

Обратное проецирование с фильтрацией аналогично методу обратной 

проекции за исключением того, что профили до обратного проецирования 

модифицируются или фильтруются, т.е. в (2.12) . Это позволяет вывести 

эффект затемнения, присущий методу обратной проекции. В идеальном случае 

восстановленное изображение совершенно точное, поскольку модификация 

профилей точно компенсирует ложный сигнал, создающий нерезкое 

изображение при обратном проецировании. 

Предположим, что  есть Фурье-образ некоторой функции , 

 

(

2.16) 

тогда произведение  на Фурье-образ проекции можно рассматривать 

как Фурье-образ свертки самой проекции и  

 

(

2.17) 

из (2.12) следует, что формула описывающая метод обратного 

проецирования с фильтрацией свёрткой при измерении конечного числа 

проекций будет: 

 

(

2.18) 

где  - результат свертки измерений проекции  с некоторой 

функцией , называемой ядром свертки. Как и в методе обратного 



проецированияМетод обратной проекции, суммирование идёт по М - 

количеству проекций, а коэффициент  представляет угловое расстояние 

между соседними проекциями. 

Точное вычисление  невозможно ввиду расходимости этого 

интеграла, но это и не нужно, т.к. дискретизация отсчетов на проекциях через 

интервалы автоматически ограничивает область 

задания  максимальным значением . Ядро  в 

пределах от  до  вычисляется: 

 

(

2.19) 

Если положить , то . 

, если  четное, 

 , если  нечетное. 

 
Рис. 2.5. Функция ядра свёртки (по обеим осям относительные единицы). 

Такое ядро впервые было исследовано А. Лакшминараянаном и 

Г.Рамачандраном и обычно называется их именами. Следует отметить, что 

выбор ядра существенно влияет на качество восстанавливаемого изображения. 

Поэтому выбор ядра является предметом тщательного исследования с учётом 

особенностей объекта, подлежащего восстановлению. 

Процедура восстановления функции по методу обратной проекции с 

фильтрацией сверткой будет следующая: 

1. Находим функцию  как интеграл свертки проекции  с 

функцией ядра свертки . 

2. Определяем функцию  в точках v. 

3. Вычисляем искомую функцию , используя уравнение (2.18). 



Удобство алгоритма обратной проекции с фильтрацией состоит в том, что 

вычислительный процесс восстановления может идти почти одновременно с 

регистрацией проекции: как только получена очередная проекция , 

осуществляется ее свертка с ядром  и добавление данных в ячейки памяти, 

накапливающие результаты суммирования по формуле (2.18). Как только 

обработана последняя проекция, функция восстановлена. 

2.5 Итерационные методы восстановления 

2.5.1 Определение. 
Термин “итерационный” относится к методу последовательных 

приближений, при котором выбирается произвольное начальное изображение; 

для него рассчитываются проекции, а затем в изображение вводятся поправки 

для лучшего согласования этих проекций с измеренными проекциями. 

Итерации повторяются до тех пор, пока не будет получена удовлетворительная 

сходимость. 

2.5.5 Алгебраический метод восстановления (ART) или получевая 

коррекция. 
Этот метод был независимо разработан Гордоном и др., который назвал 

его методом алгебраического восстановления (ART – Algebraic Reconstruction 

Technigues). Процедура восстановления следующая. В каждой итерации 

вычисляется сначала одна лучевая сумма при исходном значении плотности в 

ячейках . По ней и с учетом измеренной лучевой суммы определяется 

поправка, которая вводится во все точки, входящие в состав данного луча. 

Затем операция повторяется для второго луча, третьего и т.д. При этом 

поправки, введенные от предыдущей лучевой суммы, учитываются в каждом 

новом расчете. Эти операции продолжаются до тех пор, пока не будут 

обработаны все проекции, после чего итерация завершена. Если критерий 

получения решения не удовлетворён, то происходит переход к следующей 

итерации. 

Рассмотрим элементарный пример реконструкции двумерного объекта, 

когда сам объект предельно прост, алгоритмический “механизм” совершенно 

прозрачен, а привлечения ЭВМ вообще не требуется. 

Возмём в качестве такого объекта квадрат ABCD (рис. 2.7.), разделённый 

на 9 равных клеток (ячеек). Числа от 1 до 9, разбросанные по клеткам, 

соответствуют плотности или какой-нибудь другой характеристике, находимой 

томографически. Пусть известны 4 проекции, определяемые направлениями 

сторон квадрата AB и AD и его диагоналей AC и BD. Если в каждой проекции 

взять по 3 луч-суммы, то в первых двух случаях вклад внесут все клетки, а в 

двух других лишь по 7 клеток из 9. Таким образом, мы исходим из 12 значений 

луч-сумм и ищем 9 структурных элементов объекта, т.е. решаем 

переопределённую задачу. 



 
Рис. 2.7. Тест-объект из девяти элементов. 

Начнем с проекции, образованной лучами, параллельными стороне AB. 

Каждое значение луч-суммы разделим на число пересекаемых клеток и 

припишем этим клеткам найденную величину (в данном случае 5). Будем 

считать полученный результат первой итерацией (рис. 2.8 A). Как видим, в 

нашем случае для взятой проекции объект представляется совершенно 

однородным; если погрешность восстановления оценивать по формуле 

 

(

2.26) 

где индекс ‘k’ нумерует клетки, i обозначает номер итерации, - 

исходные значения на рис. 2.7., то . 

Перейдем к следующей проекции (лучи идут вдоль AD). Теперь для 

каждого луча следует скорректировать сумму чисел, получаемых после первой 

итерации, на известную луч-сумму данной проекции. Так, сумму в первом 

столбце (15) следует, очевидно, уменьшить на 2 и вычесть из каждого числа по 

2/3; в третьем столбце нужно, наоборот, добавить в каждую клетку по 2/3; во 

втором столбце изменений нет. Видно, что в нашем примере вторая итерация 

фактически оказывается неинформативной: предыдущее однородное 

распределение лишь слегка деформируется, создавая небольшой градиент 

вдоль AB и совершенно не выявляя сложной структуры объекта (рис. 2.8 B). 

Погрешность восстановления, оцениваемая по (2.26), даже несколько 

возрастает по сравнению с первой итерацией: . 



 

 

 
Рис. 2.8. Различные стадии (A-F) восстановления тест-объекта, 

изображенного на рис.2.7. 

Третья Итерация (рис. 2.8 C, лучи идут параллельно диагонали AC) уже 

резко меняет дело, поскольку в значениях луч-сумм неоднородность объекта 

проявляется отчетливо. Принцип остается прежним, только соответствующие 

разности следует равномерно распределять по двум или трем клеткам в 

зависимости от того, какая луч-сумма принята в расчет; . 

Аналогичная ситуация имеет место и с четвертой итерацией (рис. 2.8 D), 

завершающей первый цикл процедуры; теперь объект уже напоминает 

исходный, . 

Далее можно вновь привлечь первую проекцию и начать, таким образом, 

второй цикл. На рис. 2.8 Е,F показаны результаты, получаемые после шестой (

) и восьмой ( ) итерацией. Процесс можно было бы, 

конечно, продолжать и дальше, но уже и из проделанных выкладок ясно, что 7-

8 итераций позволяют получить неплохой результат восстановления. 

2.5.6 Итерационный метод наименьших квадратов (ILST) или 

одновременная коррекция. 
В простейшем случае алгоритм этого метода (ILST- Iterative Least-Squares 

Technique) следующий. Все проекции вычисляются в начале итерации при 

исходном значении плотности ячеек . По расчетным проекциям 



определяются поправки для каждой ячейки . А затем коррекции вводятся 

одновременно во все ячейки. На этом итерация завершается. Таким образом в 

этом алгоритме не производится уточнение значения плотности в ячейке  в 

течении итерации. Изменяется плотность в  один раз за итерацию. Этот 

метод впервые применен Р.Брейсвеллом. Он же показал, что в таком варианте 

алгоритм приводит к перекоррекции, в результате чего итерации колеблются 

вокруг правильного решения. 

Глава 3. Описание программы TOMOGRAPHY1. 

3.1 Введение. 
Одним из современных методов диагностики плазмы является метод 

реконструктивной компьютерной томографии. Томографический подход 

позволяет с достаточно высокой степенью точности определять локальные 

характеристики исследуемых неоднородных плазменных объектов, что даёт 

широкие возможности в понимании физических процессов, протекающих в 

этих объектах. Качество реконструкции существенно зависит от таких 

факторов, как число направлений наблюдения (ракурсов), количество 

детектирующих устройств, устойчивость алгоритма к шумам. 

Численное моделирование позволяет определить оптимальные условия 

постановки томографического эксперимента. 

Разработанная обучающая программа “Tomography 1” позволяет 

вычислять проекции математических моделей неоднородных плазменных 

объектов, наглядно демонстрировать восстановление осесимметричного и 

асимметричного объектов при выбранном числе проекций (ракурсов 

наблюдения), накладывать на проекции шумы, представлять результаты 

восстановления в трёхмерном виде, воспользовавшись нормировкой, 

определять точность восстановления, и проводить общий анализ зависимости 

точности восстановления объекта от числа проекций. 

Работа реализована на основе одного из самых мощных аналитических 

способов решения задачи восстановления - преобразования Фурье - и 

вытекающие из него вычислительные методы непосредственно использованы в 

этой программе: "метод обратной проекции" и "фильтрация сверткой". 

Несмотря на то, что метод обратной проекции восстанавливает 

изображение со значительными ложными сигналами и в настоящее время не 

применяется, он приводится потому, что очень прост, интуитивно понятен, 

нашел применение в первых экспериментах и, самое главное, входит в состав 

основных точных методов. Кроме того, представляется возможность наглядно 

сравнить оба способа восстановления. 

Метод же обратного проецирования с фильтрацией используется во 

многих современных рентгенодиагностических томографов и, таким образом, с 

чисто утилитарной точки зрения играет особую роль. 

Также в программе реализованы два итерационных метода томографии: 

алгебраический метод восстановления (ART- Algebraic Reconstruction 

Technigues) или получевая коррекция и итерационный метод наименьших 



квадратов (ILST - Iterative Least-Squares Technique) или одновременная 

коррекция. 

3.2 Описание программы. 
При запуске программы “Tomography1.exe” на экране появляется главное 

окно – “Tomography 1” (рис.3.1), 

 
Рис.3.1 Главное окно программы Tomography 1. 

на котором расположены компоненты, позволяющие задавать параметры 

и управлять работой программы: 

 
Рис.3.2 

В меню “File” (рис.3.2) 

предусмотрена возможность выхода 

из программы (Exit), сохранения 

полученного графика в BMP 

формате (Save graph), сохранение 

смоделированных проекций в txt 

формате (Save model projections), 

сохранить обработанные данные в 

txt формате (Save treated datas), 

загрузка экспериментальных 

данных (Open experimental 

projections). 

 
Рис.3.2a 

В меню “Regime” (рис.3.2a) 

задается режим работы программы: 

работа с мат. моделями (Model), 

работа с загружаемыми 

экспериментальными данными 

(Experimental data) 



 
Рис.3.3 

Из меню “Options” 

вызываются модули для задания 

математической модели (Model…), 

показа заданной модели в 3-х 

мерном виде (Show model…), 

задания уровня шумов (Noise 

level…), установки параметров 

отображения восстановленного 

объекта (Set-up of an image…), 

вывод информации о точности 

восстановления объекта (Error…). 

 
Рис.3.4 

Из меню ”Help” вызывается 

подробная справка по описанию 

программы “Tomography 1” и 

методическая информация по 

томографии (понятие томографии, 

математическое описание методов 

томографирования, особенности 

томографии плазменных объектов) 

 
Рис.3.5 Справочная система программы Tomography 1. 



 
Рис.3.6 Задание мат. модели. 

из меню “Options”, 

главного окна, 

вызывается модуль для 

задания математической 

модели (Model…) 

(рис.3.6). В окне 

пользователь выбирает 

комбинацию 

функций Гаусса (до 9 

штук), задает 

коэффициенты (a и b) и 

устанавливает 

максимальные 

(Xmax,Ymax) и 

минимальные 

(Xmin,Ymin) значения 

по осям. Далее 

нажимается кнопка 

“Show model” для 

просмотра самой модели 

(рис.3.6a). 



 
Рис.3.6a Созданная пользователем модель. 

В правом верхнем углу указывается растр модели (Raster NxN), “Turn of a 

system ” – показывает углы поворота системы координат (“X”,”Y”,”Z”). 

Предусмотрена возможность поворота простым движением мышки. Кнопка 

“Show” служит для перерисовки модели, если она была изменена. Normalization 

выделяется, если нужно осуществить нормировку модели (при определении 

погрешности восстановления нормировка происходит автоматически). В меню 

“File”,”Options” и “Help” аналогичные пункты, что и в главном окне. 

После того, как задана модель, нужно вернуться в главное окно (рис.3.1) 

(оно все время открыто). Компоненты, расположенные на нем, позволяют 

осуществлять: 

 

Для просмотра проекции с математической 

модели, задается число отсчетов – “Readount on a 

projection”, угол поворота“Turn angle” и нажимается 

кнопка “Projection”(рис.3.7) (результат на рис.3.9a). 

Для вывода ядра свертки, выбирается ядро (Nucleus 

Ramachandrana или MHAT wavelet) и нажимается 

кнопка “Nucleus”(рис.3.7) (результат на рис. 3.9с,10). 

Для просмотра свертки ядра с выведенной проекцией 



Рис.3.7 нажимается кнопка “Convolution” (рис.3.7) (результат 

на рис. рис.3.11,12). 

 
Рис.3.8 

Для восстановления модели задается растр 

томограммы “Raster tomography NxN”, число проекций 

“Amount of projections M”, угловой шаг “Angular pitch”, 

алгоритм восстановления “Algorithm”, указывается 

проводить ли нормировку “Normamalization” и 

нажимается кнопка “Reconstruction”. Для вывода на 

экран предназначена кнопка “Show”. 

В режиме обработки экспериментальных данных 

(Regime-> Experimental data) может произвольно 

задаваться угловой шаг (но не рекомендуется менять 

загруженное значение), выбирается алгоритм 

восстановления, растр томограммы и число проекций 

устанавливаются автоматически. 

 
Рис.3.8a 

 
Рис.3.8b 

Программа позволяет на 

смоделированные проекции накладывать 

случайный шум “Options->Noise 

level”(Рис.3.8a). Амплитуда шумов 

устанавливается в процентном соотношении от 

текущего значения отсчета (Рис.3.8b). 

Сгладить проекцию с шумом можно, применив 

метод наименьших квадратов “To smooth” 

(Рис.3.8b). Пример проекции с 20-ти 

процентным шумом показан на Рис.3.9b. 



 
Рис.3.9a Проекция с мат. модели под углом 20 градусов, 100 отсчетов. 

 
Рис.3.9b Проекция с мат. модели под углом 20 градусов, 100 отсчетов, 

с 20-ти процентным шумом (график красного цвета), 

сглаженная проекция (график зеленого цвета) 



 
Рис.3.9c Ядро Рамачандрана. 

 
Рис.3.10 MHAT wavelet. 



 
Рис.3.11 Свертка проекции с MHAT wavelet. 

 
Рис.3.12 Свертка проекции с ядром Рамачандрана. 



Ниже приведены изображения с восстановленными моделями с 

использованием различных алгоритмов. 

 
Рис.3.13 Метод обратной проекции (погрешность восстановления 

55.219%). 



 
Рис.3.14 Метод обратной проекции с фильтрацией 

сверткой (погрешность восстановления 6.083%, ядро Рамачандрана). 

 
Рис.3.15a 

 
Рис.3.15b 

Алгоритмы ART и ILST являются 

итерационными, поэтому перед восстановлением 

проекций данными алгоритмами, нужно задать 

число итераций. Для этого в блоке “Alkhoritm” 

кликаем правой кнопкой мыши на пункт “Art” или 

”ILST” для вызова выпадающего меню “Iterations” 

(Рис.3.15a). Появляется окно “Iterations” 

(Рис.3.15b), где можно задать число итераций в 

алгоритме восстановления. 



 
Рис.3.15c Метод ART (погрешность восстановления15.511%, 10 

итераций). 



 
Рис.3.16 Метод ILST (погрешность восстановления 15.876%, 5 итераций). 

 
Рис.3.17 Вывод информации 

о точности восстановления. 

Из меню “Options->Error…”, 

главного окна, вызывается модуль 

вывода информации о точности 

восстановления объекта “Exactness” 

(Рис.3.17). В модуле определяется 

как общая погрешность “To 

calculate”, так и абсолютная 

погрешность каждого элемента 

восстановленного объекта (The 

absolute error). Абсолютная 

погрешность выводится в виде 

некоего поля ошибок (рис.3.18) 



 
Рис.3.18 Абсолютная погрешность (поле ошибок). 

Разность между идеальной моделью и восстановленной методом 

обратного проецирования. До определения абсолютной погрешности и модель, 

и восстановленный объект были нормированы. 

 
Рис.3.19 Параметры отображения 

В программе можно 

задать параметры 

отображения 

восстановленного объекта 

(Меню “Options-> Set-up of an 

image…”). 

“Points”-отобразить 

объект точками (рис.3.20) 

(при этом существенно 

экономятся вычислительные 

ресурсы); 

“Triangulation”-

триангуляция объекта; 

“Halftints”- отобразить объект 

полутонами (рис.3.21); 

“Site”- отобразить 

сетку; “Axes” – показать оси 



координат; “Grid”- показать 

основание. 

“Color triangulation”- 

цветная триангуляция 

(рис.3.22). 

 
Рис.3.20 Отображение объекта точками. 



 
Рис.3.21 Отображение объекта полутонами. 

 
Рис.3.22 Отображение объекта в цветной триангуляции. 



Практические задания к лабораторной работе. 

Порядок работы. 

1. Внимательно ознакомиться с данным методическим руководством. 

2. Запустить обучающую программу Tomography1.exe 

3. Убедиться, что установлен режим моделирования (“Regime”). 

Создание математической модели неоднородного плазменного объекта. 

4. Создать математическую модель из комбинаций функций Гаусса (не 

менее 3-х функций). “Принтскрином” сохранить в графическом файле. 

Моделирование проекций. 

5. Вывести графики проекций с созданной мат. модели (не менее 3-х под 

различными углами). Сохранить графики в файлах (File->Save graph) 

6. Получить графики сверток проекций с ядрами (Рамачандрана и MHAT 

wavelet). Не менее 3-х под углами, использованными в пункте 5. Сохранить 

графики в файлах (File->Save graph). Проанализировать вид графиков сверток, 

сравнить их с обычными проекциями, написать вывод. 

Работа с алгоритмами томографии и определение влияния числа 

используемых проекций на точность восстановления. 

7. В блоке Reconstruction задать: растр томограммы (не менее чем 50х50), 

число проекций 2, рассчитать угловой шаг и задать его. 

8. Выбрать алгоритм томографии “Revers projection” и обработать им 

проекции. Вывести результат обработки на экран с установками отображения 

(Set-up of an image): Triangulation, Color site, Axes. Определить точность 

восстановления. “Принтскрином” сохранить изображение в графическом 

файле. 

9. Повторить пункты 7 и 8 для числа проекций 3,4,5,6,10,12. 

10. Построить график зависимости точности восстановления от числа 

используемых проекций. Проанализировать график, написать вывод. 

11. Повторить пункты 7,8,9,10 для алгоритмов томографии “Filtration by 

convolution” и “ART” (для “ART” задать число итераций равное 5). Сравнить 

полученные графики, написать вывод. 
Влияние шумов на профили проекций. 

12. В блоке “Noise level” задайте уровень шумов 15%, включите 

сглаживание шумов, получите график проекции с заданным уровнем шума и 

сохраните график. 

13. Получите свертку зашумленной проекции с ядроми Рамачандрана и 

MHAT wavelet (сохраните графики). Проанализируйте полученные графики, 

сделайте предположение о результате обработки подобных данных алгоритмом 

томографии “Filtration by convolution”. 

Влияние шумов на точность восстановления в различных алгоритмах 

томографии. 

14. В блоке Reconstruction задать: растр томограммы (не менее чем 

50х50), число проекций 10, рассчитать угловой шаг и задать его. В блоке “Noise 

level” задайте уровень шумов 15%, выключите сглаживание шумов. 



15. Выбрать алгоритм томографии “Filtration by convolution” и выполнить 

обработку. “Принтскрином” сохранить изображение в графическом файле. 

16. В блоке Reconstruction задать: растр томограммы (не менее чем 

50х50), число проекций 10, рассчитать угловой шаг и задать его. В блоке “Noise 

level” задайте уровень шумов 15%, включите сглаживание шумов. 

17. Выбрать алгоритм томографии “Filtration by convolution” и выполнить 

обработку. “Принтскрином” сохранить изображение в графическом файле. 

18. Повторить пункты 14,15,16,17 для алгоритмов “Wavelet filtration” и 

“ART”. Напишите сравнительный анализ полученных результатов. 

19. Внимательно перечитайте раздел “2.5.5 Алгебраический метод 

восстановления (ART) или получевая коррекция “. Придумайте свой тест-

объект размером 16 клеток (4х4) и распишите 6 итераций восстановления с 

указанием точности восстановления. 

Отчет должен содержать полученные рисунки, графики с комментариями 

и выводами, а так же выполненную самостоятельную работу по пункту 19. 

Отчет представляется в электронном виде. 

 

Контрольные вопросы: 

1. Для чего необходимы томографические исследования. 

2. Назовите правила проведения томографического исследования. 

3. Назовите основную классификацию методов вычислительной 

томографии.. 

4. В чем выражаются особенности томографии плазменных объектов? 

5. Как происходит восстановление сечений с использованием Фурье 

преобразований? 

6. Расскажите о методе обратной проекции 

7. Как происходит обратная проекция с фильтрацией свёрткой? 

8. Расскажите об алгебраическом методе восстановления (ART). 

9. Расскажите об итерационном методе наименьших квадратов (ILST). 

10. Нарисуйте схему вычислительной томографии 

11. Расскажите о классификации методов вычислительной томографии 

12. Расскажите о методе обратной проекции. 

  



Лабораторная  работа №2 

 

Реконструктивные методы в томографических 

исследованиях 

 

Постановка задачи 

Рассмотрим задачу восстановления рентгеновского изображения 

на примере рентгеновского томографа с параллельной схемой 

сканирования (см. рисунок 1) [1-6]. 

 

 

Рисунок 1 - Параллельная схема сканирования 

 

 



На рисунке 1 показано сечение D исследуемого объекта, 

характеризуемое плотностью вещества, точнее, коэффициентом 

поглощения рентгеновских лучей f(x,y),  где х ,  у  -  неподвижная 

относительно объекта система декартовых координат (с ней 

совмещена система координат x’, y’, необходимая далее). 

Расположенные на раме рентгеновские трубки излучают 

узконаправленные рентгеновские лучи интенсивности I0, которые, 

пройдя через вещество и испытав частичное поглощение, 

регистрируются соответствующими детекторами (приемниками). 

Такой эксперимент проводится для ряда значений угла поворота 

рамы φ [0,π) . 

Введем вращающуюся (неподвижную относительно рамы) 

систему декартовых координат s , l .  Тогда можно обозначить через 

I(s, φ) значения интенсивности излучения, принятые детекторами. 

Обозначим далее 

 
 I s,φ

q s,φ =-ln
I0

.  ( 1 )  

 

Отношение  
 I s,φ

I0

 принято называть прозрачностью, а 

функцию  q s,φ  - поглощением [6, с. 19], или тенью. Искомая 

функция f(x,y) связана с измеренными значениями  q s,φ  

интегральным уравнением Радона [1-4, 6], или теневым уравнением: 

 

   
 φ

φ

L s,

Rf f x,y dl q s, , 
 

 

где R - оператор преобразования Радона (оператор теневого 

преобразования), а интегрирование ведется по лучу в виде прямой 

L(s,φ), уравнение которой 

 

х cosφ+ у sinφ= s                                                                            (2) 

 



Интеграл  
 φL s,

f x,y dl  называется массой вещества на луче 

зрения [6, с. 19], а q(s,φ) в данном случае является набором исходных 

интегральных проекций (тенью изображения). 

Тень изображения при фиксированном угле φ обозначим через 

φq ( s )и будем называть линейной интегральной проекцией 

изображения q под углом φ . 

Заметим, что существует еще схема веерного сканирования 

(более распространенная схема), для которой также справедливо 

уравнение типа (2) [4]. 

 

Виды задач реконструкции 

 

Задача реконструкции рентгеновского изображения сводится к 

решению интегрального уравнения типа (2) относительно f(x,y) по 

известным значениям q(s,φ). При этом существует два типа задач 

реконструкции: задача с полными данными и задача с неполными 

данными [4]. 

В задаче с полными данными предполагается, что исходные 

интегральные проекции q ( s ,φ )  известны вдоль всех лучей, 

проходящих через исследуемое сечение D, т.е. при всех необходимых 

значениях s и φ . 

Задачи с неполными данными могут быть следующих типов: 

1. задача с ограниченным диапазоном углов, 

2. внешняя задача, когда функция q ( s , φ )  задана лишь для | s  

|> а , где а  > 0, 

3. внутренняя задача, когда q(s,φ) задана лишь для | s |< а, где 

а > 0, 

4. задача с ограниченным числом источников и приемников 

излучения. 

Что касается аналитических и численных методов решения 

уравнения (2), то известны следующие аналитические методы, 

согласно формуле обращения Радона [2, 4] и согласно формуле 

обращения Кормака [4]. Также существуют следующие численные 

методы, метод преобразования Фурье, метод свертки и обратной 

проекции, метод итераций и методы регуляризации. 

Многие из этих методов исследованы достаточно подробно [1-

6], однако остался ряд нерешенных вопросов. Например, в методе 



свертки и обратной проекции [4, 5] имеет место явная расходимость 

решения f ( x , y )  и, чтобы ее устранить, используется предельная 

(максимальная) частота Фурье, хотя, как известно [7, с. 259-261], 

более эффективно устраняют расходимость методы сглаживающих 

окон и, тем более, метод регуляризации Тихонова. Это показано в 

работе [3, с. 33], однако введенный в ней стабилизирующий 

множитель можно значительно упростить, что и предлагается в 

данной работе. 

Кроме этого, в качестве метода итераций в [4] использован 

метод Качмажа. Между тем, более эффективным представляется 

метод итеративной регуляризации Фридмана [7, с. 272]. 

Наконец, представляются совершенно новые возможности в 

решении задачи реконструкции рентгеновских изображений в связи с 

приведением «неудобного» уравнения (2) к стандартному уравнению 

– двухмерному интегральному уравнению Фредгольма I рода типа 

свертки [8]: 

 

 

   
 

2 2

f x', y' dx' dy'
S x,y ,

х х' y y'

 

 



  
   (4) 

 

Где 

 

   
π

0

1
φ φ φ φ

π
S x,y q xcos sin , d .   (5) 

 

Уравнение (4) уже исследовалось [2] и применялось на практике 

[1], однако до настоящего времени не рассмотрен вопрос о его 

решении в случае задачи с неполными данными. 

 

Метод преобразования Фурье 

 

Этот хорошо известный метод основан на непосредственной 

численной реализации теоремы Брейсуэлла о центральном или 

проекционном слое (проекционной теоремы) [9]: 

 

   ω φ ω φ ω φq , f cos , sin ,
 (6) 



    ωω φ φ i sq , q s, e ds,






    (7) 

     1 2ω ω
1 2ω ω

i x y
f , f x,y e dxdy,

 
 

 

    (8) 

- преобразования Фурье (ПФ). Искомая функция в форме 

обратного ПФ равна 

 

     1 2ω ω
1 2 1 22

1
ω ω ω ω

4π

i x y
f x,y f , e d d .

 


 

    (9) 

 

Однако при численной (дискретной) реализации Фурье-

алгоритм дает значительные искажения (артефакты) [4]. Это связано 

с тем, что в (9) требуется знание  1 2ω ωf , , а из (6) мы получаем. 

Поэтому при дискретизации задачи требуется интерполяция, что 

ведет к большему числу операций и потере точности [4]. 

Для устранения недостатков стандартного алгоритма ПФ 

разработаны усовершенствованные Фурье-алгоритмы [4]. Тем не 

менее, более популярным и эффективным является алгоритм свертки 

и обратной проекции. 

 

Метод свертки и обратной проекции 

 

Данный метод, восходящий к работам [10, 11] и нашедший 

последующее развитие в работах [3-5] и др., является дальнейшей 

эволюцией Фурье-алгоритма и позволяет полностью избежать 

интерполяции за счет перехода от декартовых координат ω1, ω2 к 

полярным координатам ω,φ в пространстве частот. Искомое решение 

имеет вид [3, с.32]: 

 

     
π

2

0

1
φ φ φ φ

4π
f x,y d q s, p xcos y sin s ds,





     (10) 

  ωω ωi tp t e d





   (11) 

 



- так называемая импульсная реакция фильтра с частотной 

характеристикой | ω |. 

Однако решение (10)-(11) дает расходимость. Действительно, 

используя формулу Эйлера и записав (11) в виде 

 

   
0

2 ω ω ωp t cos t d ,



   (12) 

 

видим, что p(t) расходится при любом  t ,   .Чтобы 

устранить расходимость, в [4, 5] вводится предельная частота 

π
ωmax ,

h
 , где h - шаг дискретизации, в результате 

 

   
2

2 2ω ω
ω ω

2 2

max max
max max

t
p t sinc t sinc .

 
   

 
 (13) 

 

Такой устойчивый алгоритм часто называют решением в 

пространстве π hS  [7, с. 259], но он является самым грубым из 

устойчивых алгоритмов. Более эффективное подавление высоких 

гармоник Фурье обеспечивают методы сглаживающих окон [7, с. 

259-260]. А наиболее эффективным является метод регуляризации 

Тихонова [7, с. 260- 261]. 

 

Метод регуляризации Тихонова 

 

Применение данного метода в работе [3, с. 33] позволило 

получить устойчивый (регуляризованный) вариант решения (10)-(11) 

в форме: 

 

     
π

α α2

0

1
φ φ φ φ

4π
f x,y d q s, p xcos y sin s ds,





     (14) 

 

Где 

 



    ω
α αω ω ωi tp t W e d ,





   (15) 

 

α˃0 – параметр регуляризации, 

 

 
 

 

2

α 2 2

ω
ω

ω αω p

H
W

H



 (16) 

 

- стабилизирующий множитель, причем 

 

 
1

ω
πω

H ,  (17) 

 

р-1,2 ,3 . . .  -  порядок регуляризации. Обычно р=1, а α 

выбирают способом невязки 

или способом подбора [6. с. 194], [7, с. 242-249]. 

Однако выражение (16) является довольно громоздким. Более 

простым, но столь же эффективным, как следует из работы [12] (см. 

также [б. с. 170]), является определение стабилизирующего 

множителя в виде 

 

 α 2

1
ω

1 αω p
W .

  
 

Метод итераций Фридмана 

 

Основное достоинство методов итераций заключается в том, что 

они пригодны для восстановления томографических изображений в 

случае задачи с неполными данными. В качестве примера рассмотрим 

метод итераций Фридмана [7, с. 272].  

Недостатком алгоритма последовательных приближений 

является то, что сходимость гарантируется только при условии 
2

0 β 2 / R  , а это требует знания нормы оператора R. Эту норму 

обычно трудно или невозможно вычислить аналитически. Поэтому на 

практике берут достаточно малое значение β. Кроме того, 

определенную сложность представляет определение числа итераций 



(процесс итераций сходится лишь в случае точных значений q(s,φ) , а 

при наличии шумов он расходится из-за некорректности задачи). 

Обычно число итераций выбирают по невязке [7, с. 273- 274] или по 

поправке [7, с. 274-275]. В данной работе число итераций n 

выбиралось способом подбора - путем выбора такого числа итераций, 

при котором изображение восстанавливается наилучшим образом с 

точки зрения зрительного восприятия. Такой способ, конечно, 

содержит элемент субъективности, однако он основывается на 

априорной информации о решении и, как показывает решение 

различных модельных примеров, является весьма эффективным. 

 

Моделирование 

 

На основе метода свертки и обратной проекции, а также метода 

итераций Фридмана было разработано программное обеспечение на 

языке Delphi для проведения модельных экспериментов. Ниже 

приведены результаты решения некоторых модельных примеров. 

На рис. 2 показаны примеры исходных изображений размером 

512 х 512 пикселей. После решения прямой задачи томографии 

получены тени изображений, показанные на рис. 3. После 

восстановления изображений методом свертки и обратной проекции 

и методом итераций Фридмана получены восстановленные 

изображения (рисунки 4 и 5). 

Итак, в данной работе показана эффективность использования 

метода регуляризации Тихонова и метода итераций Фридмана для 

реконструкции рентгеновских изображений. 



 

 

 
 



Итак, в данной работе показана эффективность использования 

метода регуляризации Тихонова и метода итераций Фридмана для 

реконструкции рентгеновских изображений. 

 

 
 

 



 



Контрольные вопросы: 
 

1. Как осуществляется параллельное сканирование? Нарисуйте 

схему. 

2. Расскажите о методе итераций Фридмана 

3. Расскажите о методе регуляризации Тихонова 

4. Расскажите о методе свертки и обратной проекции 

5. Расскажите о методе преобразования Фурье 

6. Какие существуют виды задач реконструкции? 

7. Напишите интегральное уравнением Радона. 



Лабораторная работа №3 

 

Исследование алгоритма обратного проецирования 

 

1. Цель работы: Получить навыки практической реализации 

реконструкции томографических изображений. 

 

2. Краткие теоретические сведения 

Наипростейший алгоритм реконструкции состоит в том, что 

оценку плотности в любой точке находят путем сложения лучевых 

сумм для всех лучей, проходящих через данную точку. Это алгоритм 

суммирования или обратного проецирования. 

Традиционная томография, по существу, является методом 

обратного проецирования. В этом случае линейное ослабление в точке 

А (рис.1) оценивается путем сложения (интегрирования) суммарной 

плотности вдоль путей от Xt до At в течении времени Т (t[0,Т]). 
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Рисунок 1 - Получение изображения сечение С в традиционной 

томографии 

 

Напомним, что At (точка А принадлежит сечению С) - всегда одна 

и та же точка на передвигающейся фотографической пластинке Р 

(длина отрезка А1А2 равна нулю), в отличии от точки D (отрезок D1D2 

не равен нулю) и потому А является единственной общей точкой для 

любых путей от Xt до At в различные моменты t. Все виды 

традиционной томографии, включая систему, в которой перемещение 

источника рентгеновского излучения и фотопластинки идут вдоль осей 



координат, представляют собой трехмерную версию алгоритма 

обратного проецирования.  

Введем оператор обратного проецирования В, который заданную 

функцию двух переменных р(l,) преобразует в другую функцию Вр 

двух полярных переменных таким образом, что [Вр](r,) равна 

интегралу по  величин р(l,), где l=rcos(-) равна расстоянию от 

начала координат до прямой L, проходящей через точку (r,) , и 

перпендикулярной прямой K, которая образует угол  с осью Х (рис. 2). 

Если р(l,)- лучевая сумма, связанная с переменной l, то ясно, что 

математическая идеализация алгоритма суммирования заключается в 

том, чтобы сопоставить проекционным данным р оценку 

реконструкции Вр. 
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Рисунок 2 - Соотношение аргументов функций р и Вр в 

пространстве (r, ) 

 

Метод суммирования может быть реализован различными 

аналоговыми устройствами. Например, можно использовать 

электронно-лучевую трубку, на экране которой последовательно 

отображают линии; их положение соответствует тем пучкам 

рентгеновского излучения, для которых производится измерение 

лучевых сумм, а яркость – значению лучевой суммы. Информация с 

электронно-лучевой трубки суммируется на фотографической пленке, 

причем плотность почернения модулируется пропорционально 

величине лучевых сумм. Результирующее изображение на фотопленке 

будет представлять собой реконструкцию, полученную обратным 



проецированием. Наш же интерес заключается в вычислении величины 

[Bp](r,) по матрице Y, где i-я строка матрицы Yi=p(li,) для 1<i<N.  

Ограничим наше рассмотрение схемой сбора данных для М 

равномерно распределенных в пространстве параллельных лучей в 

каждом ракурсе. Пусть  обозначает угол между направлением 

ракурсов (так, что =/M), а d - шаг между параллельными лучами и 

пусть Nd>r. 

На рис. 3 показаны как точки, для которых величина р известна, 

так и кривая, вдоль которой необходимо проинтегрировать р, чтобы 

получить 
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Рисунок 3 - Соотношение аргументов функций р и Вр в 

пространстве (l,) 

 

Метод, который обычно используют для определения интеграла 

(1) состоит из следующих двух этапов: 

Сначала аппроксимируют правую часть выражения (1) суммой: 



 

[Bр](r)







1

0

М

m

 рrcos(m, m), (2) 

 

которую называю суммой Римана для данного интеграла, затем 

производят оценку для каждого значения m величины р(rcos(m-, 

m) по известным значениям р(nd,m) (-N<n<N) путем 

интерполирования.  

В реконструктивной томографии обычно используют два метода 

интерполяции: метод интерполяции по ближайшему значению и метод 

линейной интерполяции. При интерполяции по ближайшему значению 

вычисляют р(rcos(m-,m) по величинам р(nd,m), где n выбирают 

таким образом, чтобы выражение nd-rсos(m-) имело наименьшее 

возможное значение.  

Другими словами, определение [Bр](r,) при помощи метода 

интерполяции по ближайшему значению выполняют следующим 

образом: складывают вместе лучевые суммы для лучей по одному из 

каждого ракурсов, которые являются ближайшие к точке (r,) , и 

результат умножают на .  

В лабораторной работе предлагается использовать метод 

интерполяции по ближайшему соседу. В соответствии с этим методом в 

каждом j-столбце реконструируемого изображения необходимо найти 

строки, к элементам (пикселям) которых добавляется m-вая 

проекционная сумма данного ракурса. Обратим внимание на то, что при 

ракурсах, направления которых не кратны π/2, найденные строки могут 

выходить за пределы изображения, что иллюстрируется рис. 4.  
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Рисунок 4 - Поле (матрица) восстанавливаемого изображения с 

ракурсами π/2 и π/4 

 

Если ракурс девяностоградусный, то все элементы данного j-го 

столбца лежат на прямой l
’
, в противном случае, как это показано на 

рис.4 для сорокапятиградусного ракурса, прямая l
’
 при j, находящемся в 

поле изображения, пересекает фиктивные пиксели, которые лежат вне 

поля изображения. 
 
Так как к ним проекционная сумма не добавляется, 

то при суммировании необходимо
 

использовать нормировочный 

коэффициент, который бы учитывал неоднозначность элементов, по 

которым размывается проекционная сумма от проекции к проекции как 

внутри одного и того же ракурса, так и от ракурса к ракурсу. 

Методика определения элемента (ближайшего соседа), к которому 

добавляется данная проекционная сумма, иллюстрируется листом 

MathCad, который приведен ниже. 

 



 
 

Порядок выполнения работы 

 

1. Повторите раздел «Преобразование Радона», и «Алгоритмы 

реконструктивной томографии» [1]. 

2. Составьте схему алгоритма реконструкции изображения, 

полученного Вами в результате выполнения лабораторной работы №1, 

посредством алгоритма обратного проецирования. 

3. Реализуйте полученный алгоритм на выбор: либо на любом 

алгоритмическом языке, либо используя простейший калькулятор и 

линейку, например, MATHCAD, табличный процессор EXCEL и т.п. 

4. Визуализируйте полученное реконструированное 

изображение образ и сравните его с исходным изображением. 

5. Сделайте выводы. 

 

Содержание отчета 

 

1. Компьютерная распечатка исходного изображения. Если в 

исходном файле изображение представлено в формате RGB, то, 

используя стандарт NTS, получить файл с черно-белым изображением. 



2. Компьютерная распечатка радоновского образа 

изображения, полученного в лабораторной работе №1.. 

3. Схема алгоритма обратного проецирования для 

изображения п.2. 

4. Листинг программы алгоритма обратного проецирования 

для конкретного радоновского образа п. 2. 

5. Выводы 

 

Контрольные вопросы 

 

1. Как в традиционной томографии изменяют координаты 

исследуемого сечения? 

2. Изобразите преобразование Радона для круга с центром в 

начале координат. 

3. Докажите, что одной точке в радоновском пространстве 

соответствует множество прямых (в общем случае бесконечное) в 

полярных координатах исходного изображения  f(r,). 

4. Почему при восстановлении изображений не используется 

формула обратного преобразования Радона? 

5. Поясните сущность теоремы о центральном сечении? 

6. Сколько проекций в ракурсе? Приведите необходимые 

расчеты. 

7. Что является ядром преобразования Радона?  

8. Каким параметром определяют координаты исследуемого 

сечения в традиционной рентгеновской томографии? Как выбрать 

новое сечение? 

9. Пусть у нас имеется матрица исходных данных p, элементы 

которой p[l,] - дискретные  отсчеты радоновского образа изображения 

f (r,). Представьте схему алгоритма определения восстановления 

изображения f * (r,) методом обратного проецирования. 

10. Пусть у нас имеется матрица исходных данных p, элементы 

которой p[ i
, l j ] , i M 1, , j M 1,  дискретные отсчеты 

радоновского образа изображения f(r,). Представьте одну из 

реализаций линейного цифрового фильтра, восстанавливающего 

исходное изображение f * (r,) методом обратного проецирования. 

11. Нарисуйте изображение отрезка, проходящего через начало 

координат, полученное путем обратного проецирования его 

преобразования Радона. 



12. Нарисуйте изображение точки не лежащей в начале 

координат, полученное путем обратного проецирования ее 

преобразования Радона. 

13. Дайте сравнительную оценку аддитивным и 

мультипликативным методам коррекции данных. Чем определяется их 

эффективность? 

14. Приведите анализ ошибок при восстановлении изображений 

с помощью алгоритма обратного проецирования. 

15. Приведите анализ ошибок при восстановлении изображения 

с помощью фурье-алгоритма. 

 



Лабораторная работа №4 

 

ИССЛЕДОВАНИЕ МЕТОДОВ ЛОКАЛЬНОЙ ОБРАБОТКИ 

ТОМОГРАФИЧЕСКИХ ИЗОБРАЖЕНИЙ 

 

Один из типов преобразования изображения, который удобно 

выполнять на ЭВМ - это так называемые локальные операции или 

операции свёртки. Суть их в том, что значение яркости каждого 

элемента преобразуется в зависимости от яркостей соседних элементов. 

При этом последовательно просматриваются все элементы 

изображения, но дополнительно у каждого из них просматривается и 

его окрестность - "окно" (рис. 1.1.). Размер окна часто берут равным 

3x3 или 5x5 элементов, так как при больших размерах возрастают 

затраты машинного времени. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Рисунок 1.1 - Локальная обработка изображения 

 

Операции свёртки в окнах широко применяются при обработке 

изображений, когда требуется, например, подчеркнуть контуры и 

мелкие детали или, наоборот, сгладить изображение для выявления 

крупных объектов, устранения помех. Таким образом, выходной массив 

G размером М1xМ2 формируется путём дискретной свёртки массива F 



размером N1xN2 исходного изображения с маскирующим массивом H, 

размером L1xL2 согласно формуле. 

G(m1, m2) = 


1n




2n

 F(n1, n2) H(m1-n1+1, m2-n2+1). (1.1) 

 

Для уяснения механизма взаимодействия элементов изображения 

и маскирующей последовательности рассмотрим в качестве примера 

взаимодействие двумерной последовательности конечной 

протяженности F(n1,n2), значения отсчетов которой равны 1 внутри 

1 2

двумерной маскирующей последовательностью, расположенными ниже 

и левее точек m1, m2. 

Для вычисления значения выходного отсчета G(m1, m2), с 

помощью выражения (1.1), образуем последовательность - 

произведение F(n1, n2) H(m1-n1+1, m2-n2+1). В зависимости от 

конкретного значения (m1, m2) ненулевые области последовательностей 

F(n1, n2) и H(m1-n1+1, m2-n2+1) перекрываются в различной степени. 

Можно выделить пять случаев, представленных на рис. 1.2, где 

ненулевые области каждой последовательности заштрихованы, а 

нулевые отсчеты просто не показаны. 

Случай 1. m1<0 или m2<0. Из рис.1.2. видно, что для таких 

значений (m1, m2) последовательности H(m1-n1+1, m2-n2+1) и F(n1, n2) не 

перекрываются. Поэтому их произведение, как и значение таких 

отсчетов свертки, равны нулю. 

Случай 2. 0m1<N1, 0m2<N2. Имеет место частичное 

перекрытие. Вклад ненулевых значений отсчетов в последовательность 

- произведение имеет вид 

G(m1, m2)= 


1

1 0

m

n




2

2 0

m

n

1=(m1+1)(m2+1)   (1.2) 

 

Случай 3. m1 1, 0m2N2. Здесь можно написать 

G(m1, m2)= 




1

0

1

1

N

n




2

2 0

m

n

 1=N1(m2+1)       (1.3) 

Случай 4. 0m1<N1 , m2N2. По аналогии со случаем 3 имеем 

 

G(m1, m2)=N2(m1+1).        (1.4) 

 

Случай 5. m1N1, m2N2 

 



В этом последнем случае сдвинутая ступенчатая 

последовательность H(m1-n1+1, m2-n2+1) полностью перекрывает 

импульс F(n1, n2). Тогда 

G(m1, m2)=N1N2         (1.5) 

В итоге полная свёртка имеет вид 

 

  0       при m1<0 или m2<0 

  (m1+1)(m2+1) при 0 m1< N1, 0 m2<N2 

G(m1, m2) =  N1(m2+1)    при m1>N1, 0 m2<N2  (1.6) 

  N2(m1+1)    при 0 m1<N1, m2 N2 

  N1xN2     при m1 N1, m2 N2 
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Рисунок 1.2 - Свертка квадратного импульса с 

двумерной  

ступенчатой последовательностью 



  

Её графическое изображение показано на рисунок (1.3). 

Рисунок 1.3 - Свертка двух последовательностей 

 

Приведём примеры маскирующих последовательностей 

размерностью 3х3. 
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Маски, подчёркивающие границы изображения 
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Эти маски подчеркивают границы независимо от их направления. 

Для выделения перепадов определенной ориентации, используются 

адаптированные маски: 
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"Запад"       "Северо-запад" 
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Название маски говорит о направлении перепада яркости, 

вызывающей наибольший отклик фильтра. 

Из выражения (1.1) и рис.(1.4) следует, что существуют два 

способа выбора активного элемента (элемента с координатами m1, m2) 

на исходном изображении, которые приводят в общем случае к разным 

результатам. Это иллюстрируется рис.(1.4,а) и рис.(1.4,б). 

Ранее мы договорились, что при выходе за кадр изображения мы 

имеем нулевые отсчёты. Однако в исходных данных эти отсчёты 

отсутствуют. Поэтому, чтобы программа, реализующая такое 

преобразование изображения, была работоспособна, необходимо 

расширить исходный массив, иначе говоря доопределить его до 

размерности (N1+L1-1)(N2+L2-1). Чтобы исключить краевой эффект, 

доопределяемые элементы принимают не нулевые значения, а 

значения, равные соседним элементам исходного изображения [6]. 

Если изображение состоит из достаточно большого числа 

пикселей, то достаточно исключить из исходного изображения те 

активные элементы, в которых окно выходит за кадр изображения. 
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Рисунок 1.4 - Иллюстрация краевого эффекта



1.3. ЦЕЛЬ РАБОТЫ 

Исследовать способы локальной обработки изображений. 

 

1.4. ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ  

1. Создайте базу данных изображений (можно с расширением 

.bmp) 

2. Создайте базу данных маскирующих последовательностей 

3. Запустите программы локальной обработки изображений и 

получите окно, показанное на рисунке 1.5. 

 

 
Рисунок 1.5 - Главное окно программы 

 

4. Нажмите кнопку «открыть» и выберете из базы данных 

необходимый рисунок. При этом раскроется окно, показанное на рис. 

1.6. 

5. Нажмите кнопку «открыть» в этом окне и получите окно, 

показанное на рис. 1.7.  

6. Нажмите кнопку «применить» в этом окне и проанализируйте и 

опишите те изменения, которые произошли с исходным изображением. 

7. Повторите пункты 3-6 с другими масками и другими 

изображениями. 

8. Сделайте выводы 

 



 
Рисунок 1.6 

 

 
Рисунок1.7. 

 

1.5. СОДЕРЖАНИЕ ОТЧЕТА 

 

1. Исходное полутоновое изображение. 



2. Используемые маски для обработки изображений. 

3. Изображения после обработки выбранными масками. 

4. Выводы об эффективности используемых масок. 

 

КОНТРОЛЬНЫЕ ВОПРОСЫ 

 

1. Каковы соотношения размеров исходного изображения, 

выходного изображения и маски? 

2. Как влияет на выходное изображение высокочастотная 

маска? Для каких целей целесообразно ее использовать? 

3. Как влияет на выходное изображение низкочастотная маска? 

Для каких целей целесообразно ее использовать? 

4. Как изменится программа для обработки изображения, если 

маска имеет не прямоугольную форму, например форму «креста»? 

 

 
 


